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DRV8353Rx-EVM GUI User’'s Guide

This document is provided with the DRV8353RH-EVM and DRV8353RS-EVM customer evaluation
modules (EVMs) as a supplement to the DRV835x 100-V Three-Phase Smart Gate Driver data sheet.
This user's guide details the hardware implementation of the EVM and how to use DRV835X EVM GUI
Application.

NOTE: Only operate this EVM at the default IDRIVE 150mA/300mA gate drive strength setting.
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1 Hardware and Software Setup

The hardware (HW) and software (SW) tools that follow are required for evaluation of the hardware and

software variants of the DRV8353R device:

For additional details on hardware connections refer to the DRV8353Rx-EVM User Guide.

+ DRV8353RH-EVM or DRV8353RS-EVM with ISO-F28027F

* Brushless DC Motor

« Voltage supply from 12 V to 95 V

e Code Composer Studio™ software V.6.3 and above

» DRV8353Rx EVM reference software development package
2 GUI Application
2.1 Installation (For Desktop Version Only)

Follow these steps to install the DRV835RX application:

Step 1. Download the Setup_DRV8353Rx-1.0.0_EVM.zip file.

Step 2. Extract the zip file.

Step 3. Double click on the installer to install the GUI Application. During first time installation, the
installer prompts for installation of Cloud Agent. Install it.

2.2 Getting Started With DRV8353Rx EVM GUI
The DRV8353Rx EVM GUI along with DRV8353Rx-EVM facilitates control of a BLDC Motors and change
of various settings. The DRV8353Rx EVM GUI provides functionality for identification of motor, controlling
the speed of the motor, tuning parameters of the motor-control algorithm and monitoring the device status
and faults. Use the steps that follow to get started with the GUI .

Step 1. Make sure the 1ISO-F28028F has Serial switch S4AOFF and the Boot switch S1 configured
from left to right as ON-ON-ON.

Step 2. Connect the BLDC motor to the DRV8353Rx-EVM connected to ISO-F28027F plug-in
module.

Step 3. Plug in the micro-USB cable from ISO-F28027F to the PC.

Step 4. Enable the DC power supply (for additional details on hardware connections refer to the
DRV8353Rx-EVM User Guide).

Step 5. Click on the DRV835RX EVM shortcut either on the desktop or from the start menu to run the
GUI application (Desktop Version).

Step 6. For the Online version of the GUI Application, open the URL of the application. When you
open the online version of the application for the first time, the installer prompts for installation
of Cloud Agent.

2.3 Desktop Version
Click on the DRV835RX EVM shortcut either on the desktop or from the start menu which was created
after installation to run the GUI application.

2.4 Online Version
Open the application URL in any browser. When the online version of the application is opened for the first
time, the application prompts for installation of Cloud Agent and a browser extension. Install these files to
continue to use the application in the browser.

2.5 Device Selection

1. The Application opens up with launch page as shown in Figure 1.
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Figure 1. DRV8353Rx EVM GUI (Launch Page)

2. Select the device variant which is connected by clicking on the corresponding chip icon in the right side
of the screen.

3. Upon the selecting the device, the application will take you to the device’s Home page as shown in
Figure 1.

4. The application will try to establish communication with the device. If the device selected matches with
the connected device, ‘Hardware connected. Connected to Target’ message appears in the hardware
connection status pane below as shown in Figure 2.

E =  Connected fo target. Hardware Connected.

Figure 2. DRV8353Rx EVM GUI (Device Connection Pane)

5. If you choose the device without connecting the hardware or connect a hardware other than the
selected one (if you connect DRV8353RS-EVM and open DRV8353RH open page), the hardware
pane will show the message ‘Hardware Not Connected’

6. Click on the ‘FOC Motor Control’ button to control motor using FOC (Field Oriented Control). Once the
correct device is connected, the home page will show a message ‘Device Connected’ as shown in
Figure 3.
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Figure 3. DRV8353Rx EVM GUI (Device Connected Display)

7. Click on the ‘FOC Motor Control’ button to control motor using FOC (Field Oriented Control)

8. Click on the ‘Back’ button in the Side bar menu to go back to the launch (Device Selection page).
Going back to device selection page, disconnects the application from the hardware.

2.6 FOC Motor Control Page

NOTE: If you open the Motor Control page before device is connected, a pop up covers the screen
with a message reading ‘DRV8353Rx-EVM is not connected’. The popup can be closed and
user can evaluate the application without device. On connecting the device, the application

will immediately read values the device and populate the Motor Control page with
corresponding values.

The FOC motor control page is designed to identify a permanent magnet BLDC motor and
spin it using sinusoidal modulation and field oriented control. There are modifiable
parameters to identify the motor effectively. For more detailed descriptions of the parameters

found on this page, please refer to the Instaspin quick start guide InstaSPIN-FOC™ and
InstaSPIN-MOTION™ User's Guide .
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Figure 4. DRV8353Rx EVM GUI (FOC Motor Control Page)

2.6.1 Start-Up Options
» Enable System

Click on System Enable toggle button to enable the system. This will enable the FOC. For
DRV8353RS, System Enable enables the Register Map page as well

» OffsetCalc

ADC Offsets value is recalculated when this is enabled. Length of this re-calibration is adjustable (see
the INSTASPIN FOC User’s Guide for more info). Values can be saved and loaded from user.h,
bypassing this calculation in the future. When disabled, adcBias values will be loaded from the user.h
settings only. This startup method, with Rs recalibration disabled, is commonly utilized when offsets
might have changed, but the motor has not changed. If enabled with RsRecalc Cal, it will be the
slowest but most accurate startup.

» ForceAngle

Force Angle can be thought of as trajectory generation for the angle feedback (replacing FAST over a
user set area) to the FOC controller. It creates an estimated angle that rotates at a user set rate (in
user.h). It should be used whenever FAST is not producing an accurate angle estimate, i.e. at initial
start-up and if trying to operate continuously at very low speeds. It should typically be ENABLED when
first starting, though it doesn’t have to be, FAST can still start up the motor but usually not as gracefully
and then DISABLED for normal operation, unless you have times where you run at or through very low
speeds for long enough that the FAST estimator drifts and provides poor estimates into the system

e user.h Params

If user.h Params is enabled when ‘Run’ is selected, the control system will bypass Motor ID and load
all settings from user.h, including Offset.

» Start Motor/Stop Motor

Start Motor option is enabled only when the Bus Voltage is above 9V. Clicking on the Start Motor will
start the motor identification process (If the user.h params is disabled). Use this button to Start/ Stop
motor once the motor is identified.

2.6.2 Motor Identification
Follow the steps below to perform a Motor Identification
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1. Enable the System
2. Disable user.h Params

3. Enable OffsetCalc, RsRecalc and ForceAngle selected (Recommended as per Motorware)

The ‘Motor Identified’ LED turns yellow in color indicating motor identification is in progress. Once the
motor is identified, the LED turns green in color.

NOTE: When user.h params is enabled, Motor Identification is bypassed and therefore, the LED
turns green immediately. To have the motor parameters saved in the user.h file and loaded
into the GUI embedded firmware, a new firmware binary file must be generated. To do this
task, please follow the DRV8353Rx-EVM InstaSPIN™ Software Quick Start Guide to modify
the user.h, build the new binary and embed it to the EVM GUI.

Controller and Estimator States displays various transition states involved during Motor Identification
process. The table below shows the description for each of the states. For more information, refer the
InstaSPIN-FOC™ and InstaSPIN-MOTION™ User's Guide.

Table 1. Controller (CTRL) States

Controller State

Brief Description

Start

The start state is only shown as a starting point of the entire state machine. However it does not
actually exist in the controller state machine.

Idle
CTRL_State_ldle

This state is present when the controller is waiting for user's input to start. This state is also
present when the system is waiting for user's input to start doing the locked rotor test when
identifying AC Induction Motors.

Offline
CTRL_State OffLine

The hardware offsets calibration is done during this state of the controller

Online
CTRL_State_OnLine

Motor is running in closed loop, or is being identified. The entire estimator (EST) state machine is
run when the controller (CTRL) state machine is Online

Table 2. Estimator (EST) States

Estimator State

Brief Description

Start

The start state is only shown as a starting point of the entire state machine. However it does
not actually exist in the estimator state machine.

Idle
EST_State_lIdle

During the idle state, the estimator state machine does not execute any code. It is simply
waiting for the controller state machine to change the state of the estimator.

RoverL
EST_State_RoverL

The R over L state of the estimator is executed during the motor identification process in
order to measure the electrical constant of the motor. The resulting R over L ratio is used at
the end of this state to calculate the ID and 1Q current controller gains.

Rs
EST_State_Rs

The estimator is in the Rs state when identifying the stator resistance of the motor for the
first time, or when it is recalibrating the stator resistance after the motor has been fully
identified.

Online
EST_State OnLine

The online state of the estimator is present when the motor is operating in closed loop. In
order to be in this state, the motor had to be fully identified or motor parameters had to be
provided to a header file in user.h, and the controller had been run. This is the state where
the speed reference can be changed, and when full load can be applied to the motor's shaft.

Ramp Up
EST_State_RampUp

The ramp up state of the estimator is to get the motor spinning up to a configured frequency
in order to perform other identification tasks, such as flux and inductance identification.
During this state, there aren't any parameters estimated, it only spins the motor up to a
certain frequency.

Rated Flux OL
EST_State RatedFluxOL

This is a transitional state of the estimator prior to identifying the rated flux of the machine.
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2.6.3

2.6.4

2.6.5

2.6.6

2.6.7

Table 2. Estimator (EST) States (continued)

Estimator State Brief Description

Rated Flux
EST_State RatedFlux During this state, the flux linkage of the motor from the rotor to the stator is identified.

Id Rated

EST State lIdRated Only applicable to ACIM motors, this state is present when the motor's magnetizing current

is being identified for the commanded flux defined in user.h.

Ls
EST_State Ls The stator inductance is identified during this state of the estimator.

Rr

EST State Rr Only applicable to ACIM motors, during this state, the rotor resistance is identified. The rotor

must be locked in order to perform the rotor resistance identification.

Lock Rotor This state is used to let users know that the rotor must be locked, and then controller must
EST_State_LockRotor be re-enabled after rotor is locked, to proceed with the rest of the identification process. The
controller is put in idle when the estimator is in lock rotor state.

After all parameters of the motor have been identified, the ramp down state is present to
allow some time to remove the currents flowing through the motor windings. No parameters
are identified during this state since it is only a transitional state before the end of the
identification process.

Ramp Down
EST_State RampDown

The motor identified state is also a transitional state to let the estimator state machine know
that the motor is fully identified, and after this state is done, the state machine is put back in
idle. The controller state machine is also put in idle state after the motor identified state is
finished.

Motor Ident
EST_State_Motorldentified

Spinning the Motor

After the motor is identified (Motor Identified LED turns green), the motor stops spinning and the system
gets disabled with Controller and Estimator States showing 'ldle’.

To start spinning the motor, click 'Start Motor'. Once the motor starts spinning, the Controller and
Estimator States displays 'Online'. Click 'Stop Motor' to stop spinning the Motor. The Controller and
Estimator states displays 'ldle' once the motor is stopped.

Speed Controller Tuning

P1 Speed Control cannot be auto tuned based on the motor or system parameters. Speed Controller Gain
Kp and Ki are initialized with values which works decently for larger flux motors. Tune the motor by testing
various speeds and loads or tune by step response inputs. Update the Kp and Ki values by entering the
corresponding values in the input controls. Motor speed and Maximum acceleration can be adjusted by
entering the appropriate RPM values in the input controls.

Current Controller Tuning

The Ig and Id Current PI controller gains are numerically calculated and initialized in the controls ‘Current
Controller Gain Kp’ and ‘Current controller Gain Ki'. These values can be changed by entering the
appropriate values in the controls.

User Configured Params

‘User configured params’ section displays a set of parameters configured in the user.h file of the firmware.
These values cannot be changed directly from the GUI.

Motor Params

The motor params sections consists of the various motors parameters like Rs, Ls, Flux etc.., which are
updated during Motor Identification and tuning process. The user can update these parameters before
startup or identification occurs if motor identification fails or is not optimized.
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2.6.8 Fault Status Indicator

The Fault Status indicators LED turns red and displays an error if there are any errors in the user
configured values

2.7 Registers Page (DRV8353RS Only)

Registers page is only applicable for DRV8353RS as this device is compatible with S variant to access
Register Map of the device

» Enabling the System in FOC Motor Control by clicking ‘System Enable’ toggle button enables the
Register page for DRV8353RS device.

* This page shows all the registers and their fields present on the DRV8353RS device.
» The page allows reading and writing any register, field, or bit.
» Click on the question mark icon on any register or field to get in-place data sheet help.

DRV8353RS | File  Tools  Help = x
= Menu
# | Register Map it Byt it =
Register Name Address Value Gtz
s 10 ] 3 7 3 5 4 3 2 1 0 FieLo View
+ DRVE353RS Fault Status 1
3 Faut Status 1 00000 Ox7FF .
re au e o x x DRVE353RS / Fault Status 1 / FAULTI10]
VGS Status 2 00001 0x7FO
FAULT
- Driver Gontrol 0x0002 OXTDF 1 1 1 1 1 0 1 1 1 1 1 LJ
Gate drive HS 0x0003 0x632 1 1 0 [} [} 1 1 [ 0 1 0 DRV8353RS / Fault Status 1 / VDS_OCP[9]
Gate Drive LS 0x0004 OXBAF 1 1 0 1 0 1 0 1 1 1 1
@ Ds_ocP
ocP Control 00005 Ox7CE 1 1 1 1 1 0 0 1 1 1 0
CSA Control 0x0006 OXTFF 1 1 1 1 1 1 1 1 1 1 1 DRV353RS / Fauit Status 1 / GDF{g]
Reserved 0x0007 0x001 1

[ Yeu'd
DRV8353RS / Fault Status 1/ UVLO[7]
@ uvio

DRVS353RS / Fault Status 1/ OTSD[e]
@ OTsD

DRVS353RS / Fault Status 1/ VDS_HA[5]
@ VDS _HA

DRV8353RS / Fault Status 1 / VDS_LA[4]
@ VDS LA

DRV8353RS / Fault Status 1 / VDS_HB[3]

@ \DS_HB

Figure 5. DRV8353Rx EVM GUI (DRV8353RS Registers Page)

2.8 Menu Bar Options

The following menus are available in the menu bar displayed at the top of the GUI as shown in Figure 6.
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Figure 6. DRV8353Rx EVM GUI (Menu Bar — Help Option)

281 File Menu
The File Menu has the following options
« Program Device - The user can load the appProgram.out file onto the device by clicking this option

» Load/Save Registers — The user can save (and load) a particular configuration of the registers. This
feature can also be used when no actual EVM is connected to the computer

2.8.2 Tools Menu

The only available option in this menu is to open a log pane at the bottom of the GUI which shows
different logs: information, warning, error, debug.

2.8.3 Help Menu

The Help Menu contains options to view Readme File and About Section. The about section displays the
installed software information including the application version. This section also contains the link to
support forum on the E2ZE™ online community.

2.9 Updating Firmware (.out File) - Desktop Version Only

The user can update the existing appProgram.out file with a custom compiled .out file with these steps:

Step 1. Open the runtime location of the application (for example:
C:\Users\<username>\guicomposer\runtime\gcruntime.v6\DRV8353Rx\target).

Step 2. Replace the existing appProgram.out with the new one. The .out file should have the name
appProgram.out.

NOTE: The appProgram.out file can only be changed for the Windows desktop version. The file
cannot be modified for the online version of the application.
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